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Foreword

This course was written for trainees wishing to learn to use Microsoft Word. It is
written for using Microsoft Word in the Office 2007 suite of applications. However, it
does not include a ‘New Features’ section exclusively about new features in Microsoft
Word within Office 2007. It is very easy to see a complete list of the new features in
Office v2007 in the Help menu on-screen. This courseware cannot and should not
compete with the comprehensive coverage of new features detailed by Microsoft
within the application’s help files. To do so would be to hinder learning the raw
application.

What this course seeks to do is teach the trainee Word in the hope that he/she may be
able to go and work just as well using v2002 for example and other versions. Wherever
possible, ‘version functionality’ is purposely avoided.
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MODULE 1: MODULE 1

Objectives:

At the completion of this lesson you will be able to:

e Start Documents.
e Build and Edit Documents

¢ Finish Documents.
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STARTING DOCUMENTS

This course assumes that your work or training environment uses a computer
system running Microsoft Windows. There are many versions of Windows but
they all look similar. It is the most common computer desktop interface.
However, many work-related workstations and systems operate with a
combination of windows (for general applications, such as Excel) and bespoke
or specific company systems and applications. Consequently, you may need
to switch from a bespoke environment to Windows. Your instructor or IT / IS
Manager will advise you on this.

Before you can begin using the many features of Microsoft Word 2007, you

need to know several basic skills and concepts. Identifying word processing

functions and Word screen components, creating and opening a document,

and moving around within a document are the foundations you will build on
in this course.

DEFINING WORD PROCESSING

Word is a word processing program. Like a typewriter, a word processing
program is used to create documents such as letters, memos, or reports. As
you type on your computer keyboard, text is displayed on your screen and is
stored in your computer’s memory, which is its temporary electronic storage
area.

Unlike a typewriter, a word processor enables you to make changes to a
document easily, without unnecessary retyping. For example, you can insert
and delete words, move paragraphs, and correct spelling errors. As your
document develops, you can save the changes you have made on a disk or on
another storage medium. When the document is complete, you can save and
print it.

Any formatting that can be done on a typewriter, such as setting margins and
line spacing or changing tabs, can be duplicated in a word processing
program. Word processing programs use many of the same or comparable
keystrokes as a typewriter, such as pressing ENTER (Return on a typewriter) to
move to a new line, pressing TAB to move to the next tab setting, and
pressing CAPs Lock (Shift Lock on a typewriter) to type exclusively in capital
letters.
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Word processing provides many additional functions to make document
creation much easier than on a typewriter. One of these features is word-
wrap, which moves the entire last word of a line down to the next line if it
extends beyond the right margin. Word processors also provide automatic
reformatting if you change a document’s margins or tabs after text has been
entered. Additionally, most word processors provide tools to correct spelling
and grammar errors.
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STARTING WORD

To begin working in Word, start the program from within the Windows
environment or ‘workspace’. You can usually start Word by choosing
Microsoft Word from the Start menu’s Programs submenu.

L METHOD |

To start Word:

1. On the Windows taskbar, choose Start.
2. From the Programs submenu, choose Microsoft Word.

Note: There are other ways to start Word from Windows. If
necessary, follow your instructor’s directions to start the
program.

EXERCISE
’7

In the following exercise, you will start Word.

1. Onthe Windows taskbar, The Start menu appears.
choose Start

2. From the Programs submenu, Word starts.
choose Microsoft Word
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IDENTIFYING COMPONENTS OF THE WORD
SCREEN

When you start working in Word, your monitor displays what appears to be a
blank piece of paper on your screen with a blinking black bar on the left. This
screen, the document window, is where you enter and manage your
document text. Different command interfaces and informational display
areas, illustrated in Figure 1-1, surround the document window. Each of
these items allows you to receive information about, or apply features to,
your document.
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Figure 1-1: The Document Window
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Microsoft Word is used to manage, organize, and create things with words.
That's the essence of word processing. What you see on the screen, on
Word's interface, is designed to make writing an easy and effortless task. The
largest portion of the Word screen is for composing text. It's blank and white,
just like a fresh sheet of paper. That's where you compose and format your
text.

Surrounding the text-composing area is a bewildering host of goobers.
Despite their overwhelming appearance, the things that cling to the Word
program window are there to help you write. The following list offers a quick
top-to-bottom explanation of the tabs, toolbars, buttons, and other gizmos
you see on the screen. Use Figure 1 for reference.

The title bar lists the document's title or merely Documentl until you
give the document a title by saving it to disk.

The Office button replaces the traditional File menu of most
Windows programs. Clicking the Office Button displays the Office Button
menu, a list of commands that deal with files and documents. It's the big
round button at the top left of the screen, with four colourful squares in it.

Tabs organize Word's various and sundry commands into groups
based on word-processing activities. Tabs appear and disappear
depending on what you're doing in Word.

Groups and command buttons help keep commands for the various
tabs organized. Each group contains command buttons that do specific
things to your text.

The Ruler may or may not be visible. When the Ruler is visible, it
helps you set margins and tabs. The View Ruler button (refer to Figure 1)
shows and hides the Ruler.

Below the writing area dwells the status bar. This informative strip of
graphical goodness contains trivial information about your document, as well
as the following ornaments:

Document information lists optional data specific to your document.
The View buttons specify how the blank page appears in the window.

The Zoom slider sets how large or small your document appears
inside the window.
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Don't worry about all these things now. The most important components are
shown in Figure 1-1. What's important now is that you recognise the names
of things so that you don't get lost later.

The tabs, groups, and command buttons change as you take on
various activities in Word. Although this may seem disruptive, it's quite
handy.

You can hide the Ribbon if you would rather have more room to write:
Right-click anywhere on the Ribbon and choose the Minimize Ribbon
command from the pop-up menu. To restore the Ribbon, right-click any
tab and choose the Minimize Ribbon command again.

Another part of the window, not shown in Figure 1, is the task pane. It
shows up when it's needed, to offer more choices, options, or
information.

The Windows taskbar, located at the bottom of the screen, is a part of
Windows itself and not Word. However, as you open documents in Word,
buttons representing those documents appear on the Windows taskbar.

Unlike in previous versions of Word, the tabs, groups, and command
buttons cannot be customized, moved, or resized. You can customize the
Quick Access toolbar, but that's about it.
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THE WORD 2007 RIBBON
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The three parts of the Ribbon are tabs, groups, and commands.

There are three basic components to the Ribbon. It's good to know what each
one is called so that you understand how to use it.

e Tabs. There are seven basic ones across the top. Each represents an
activity area.

e Groups. Each tab has several groups that show related items
together.

e Commands. A command is a button, a box to enter information, or a
menu.

Everything on a tab has been carefully selected according to user activities.
For example, the Home tab contains all the things you use most often, such

as the commands in the Font group for changing text font: Font, Font Size,

Bold, Italic, and so on.
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CREATING AND OPENING DOCUMENTS

Word lets you begin working in documents in two ways: by typing into a new,
blank document, or by opening an existing document. New and Open
commands are reached, using the mouse method of navigating, by clicking
the Office button first.

When you open a document, Word places a document that was previously
saved to disk in a document window. If another document is already open
when you start or open a document, Word opens an additional document
window and places the newly opened document on top of the previous one.
The document on top becomes the current document. Using the Windows
navigation status bar, at the foot of the screen, you can switch between open
Word documents (open windows) just like you switch between different
programs.

Figure 1-2: The Office Button

NAVIGATING OPEN DOCUMENTS ON THE STATUS BAR

For each document open, although they are overlaid so only one is visible,
there is an icon on the status Bar. If you click the different icons on the status
bar you can quickly switch between open documents.
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To open a document, you first need to access the Open dialog box, illustrated
in Figure 1-3. This dialog box enables you to specify the filename, as well as
the name of the folder, or organizational location on your disk, in which the
file is saved.
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Figure 1-3: The Open Dialog box in Windows XP, running Word 2007
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Figure 1-4: (For comparison) The Open Dialog box in Windows VISTA, running

Word 2007
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_ METHOD |

To create a new document:

1. Click the OFFICE button (see Figure 1-2) and then click the
New button.
2. This opens the New Document dialog box.

To open an existing document:

1. Click the OFFICE button (see Figure 1-2) and then click the
Open button.

2. In the Open dialog box, in the Look in drop-down list box,
make sure the desired folder is displayed.

3. In the Files of type drop-down list, make sure Word
Documents is selected.

4, From the filename list box, select the desired file.
5. Choose Open.

To switch between open documents:

1. Use the status bar to select open documents’ individual
icons.

EXERCISE
’7

In the following exercise, you will create and open documents.

1. Click the OFFICE button and A new document window
then click the New button. opens, and a blank document
is displayed. Document2
appears in the title bar.

2. Click the OFFICE button and The Open dialog box appeatrs.
then click the Open button.
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In the Open dialog box, in the
Look in drop-down list box,
make sure the Data folder is
displayed

In the Files of type drop-down
list, make sure Word
Documents is selected

From the filename list box,
scroll down and select
Regional Information

Choose Open

On the Windows status bar
click to choose (view)
Document?2

On the Windows status bar
click to choose (view)
Regional Information

A list of the filenames in the
Data folder appears in the
filename list box.

Filenames of Word documents
are displayed in the filename
list box.

The document opens, and the
filename Regional
Information appears in the
title bar.

The document window
containing Document2 is
displayed.

The document window
containing Regional
Information is displayed.
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MOVING THE INSERTION/CURSOR POINT

The text you type appears wherever the insertion/cursor point is positioned
in the current document. Moving the insertion point around the screen is a

critical part of creating and editing documents. To move the insertion point

around the screen, you can use either the keyboard or the mouse. Table 1-1
lists ways to move the insertion point by using keystrokes.

To use the mouse to move the insertion point, first position the desired
section of text in the document window by using the scroll bars. Then,
position the mouse pointer in the desired location and click the left mouse
button. If you are using a Microsoft IntelliMouse, you can display and move
the insertion point to a different part of the document by using the wheel
button.

Do not use the ENTER key to move the insertion point unless you want to add
hard returns, or blank lines, to your document. If, however, you want to
move the insertion point to an area of your document into which you have
not yet entered text, you need to press the ENTER key until the insertion point
is positioned in the desired location.
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Keystroke

Result

UpP, DOWN, LEFT, or RIGHT
ARROW

Moves the insertion point to the previous or next
line or character.

PAGE UpP Moves the insertion point up one screen.

PAGE DOWN Moves the insertion point down one screen.

HoME Moves the insertion point to the beginning of the
current line.

END Moves the insertion point to the end of the current
line.

CTRL+HOME Moves the insertion point to the beginning of the
document.

CTRL+END Moves the insertion point to the end of the

document.

CTRL+ PAGE DOWN

Moves the insertion point to the top of the next
page.

CTRL+PAGE UP

Moves the insertion point to the top of the
previous page.

Table 1-1: Moving the Insertion Point by Using Keystrokes
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Find and Replace [-7 | [=E3a]
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Find what: Izl
Options: Search Down
Mare = Cancel

Figure 1-5: The Find and Replace Dialog Box's Find Tab

You can also use Word'’s Find feature to help you move the insertion point.

Instead of scrolling or paging through the document to find occurrences of

specific text, you can have Word perform the search by defining the desired
text on the Find and Replace dialog box’s Find tab. Figure 1-5 illustrates the
Find tab. Finding is not limited to letters and numbers; you can search for a

phrase, including punctuation and spaces, as well.

When Word finds the desired text in the document, it highlights the text,
suspends the search, and leaves the Find and Replace dialog box open. You
can then place the insertion point at the found text, move to the next
occurrence of the text, or end the search. If the text cannot be found in the
current document, Word displays a message box indicating the text does not
appear in the document.

Once you use the Find feature, Word automatically sets the browse object to
Find. The browse object defines the manner in which you can browse
through the document. The default setting is Page, which enables you to
scroll through the entire document. If the browse object is set to a different
option, the arrows on the vertical scroll bar change colour. Unless you want
to repeat the Find operation, you should manually reset the browse object
before you continue working in your document.
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Figure 1-6: The Select Browse Object pop-up palette. With Browse by Page selected.

Find and Replace E
Replace | GoTo

Find what: |Tomab:ue |Z|
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[ Replace ] [ Replace al ] [ Eind Mext ] [ Cancel ]

Figure 1-7: The Find and Replace Dialog Box's Replace Tab

The Replace option helps to replace the particular word selected or it
changes the particular word through out the document. This feature saves our
time in searching the word and replacing one by one.

L METHOD |

To move the insertion point using the keyboard:

1. Press the appropriate directional arrow, key, or keystroke
combination.

To move the insertion point using the mouse:
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1. Position the mouse pointer at the desired location in the
document.

2. Click the mouse button.

To move the insertion point using the Find feature:

1. On the Editing group on the Home ribbon tab, choose Find.

2. In the Find and Replace dialog box, make sure the Find tab
is selected.

3. On the Find tab, in the Find what text box, type the desired
word or phrase.

4. Choose Find Next to find the next occurrence of the text.

5. Repeat step 4 as required.
or

5. In the information box, choose OK.
or

5. In the Find and Replace dialog box, choose Cancel.

6. If the desired text is found, in the document, click the
highlighted text.

To manually set the browse object:

1. On the vertical scroll bar, click the Select Browse Object
button.

2. From the pop-up palette, select the desired object.

EXERCISE
’7

In the following exercise, you will move the insertion point.

1. Make sure Regional
Information is open in the
current window

2. Press CTRL+END The insertion point moves to
the end of the document.
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10.

11.

12.

13.

14.

Press CTRL+PAGE UP until you
reach the top of the document

At the top of the document,
position the mouse pointer at
the beginning of the first
paragraph (beginning with In
addition to...)

Click the mouse button

Press the DOWN ARROW key
as many times as necessary to
move to the beginning of the
second paragraph (beginning
with Universal Studios
brings...)

Press the RIGHT ARROW key as
many times as necessary to
move the insertion point to the
beginning of the word movies

Press HOME

Press END

Press PAGE DOWN

Press CTRL+HOME

the Editing group on the Home
ribbon tab, choose Find

In the Find and Replace dialog
box, make sure the Find tab is
selected

On the Find tab, in the Find

what text box, type London
Zoo

The insertion point moves to
the top of each page as you
move up through the
document.

The insertion point is placed at
the beginning of the paragraph.

The insertion point moves to
the new location.

The insertion point moves to
the beginning of the line.

The insertion point moves to
the end of the line.

The insertion point moves
down one screen.

The insertion point moves to
the top of the document.

The Find and Replace dialog
box appears.
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15.

16.

17.

18.

19.

20.

21.

Choose Find Next

Choose Find Next

Choose Cancel

In the document, click the
highlighted text London Zoo

On the vertical scroll bar, click
the Select Browse Object
button

From the pop-up palette, select
Browse by Page (first row, last
column)

Switch to Document?2

Word locates the first
occurrence of the phrase
London Zoo and highlights it
in the document.

Word locates the next
occurrence of the phrase
London Zoo and highlights it
in the document.

The Find and Replace dialog
box closes, and London Zoo
remains highlighted in the
document. The arrows on the
vertical scroll bar change color,
indicating that Word has set
the browse object to Find.

The insertion point moves into
the text.

The browse object pop-up
palette appears.

The browse object is reset to
its default setting.

The blank document is
displayed in the current
window.
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BUILDING AND EDITING DOCUMENTS

Whether you are building a new document or have opened an existing
document, you will usually need to modify, or edit, text. Word makes it easy
to insert, delete, replace, move, and copy text. You can also insert the date
and time and modify page breaks, the dividers between pages, to make a
document more usable and easier to read.

INSERTING AND DELETING TEXT IN A DOCUMENT

You can insert, or enter, text into a new document or into any portion of an
existing document. When you insert text, any existing text is moved to the
right and down in your document. Word’s word-wrap automatically adjusts
to accommodate inserted text, eliminating the need for you to make
adjustments manually.

When you delete text, you remove it from the document. Word enables you
to delete text a character at a time by using the DELETE and BACKSPACE keys.
The DELETE key deletes text to the right of the insertion point; the BACKSPACE
key, to the left.

L METHOD |

To insert text into a document:

1. Place the insertion point where you want to begin typing.
2. Type the text.

To delete text from a document:

Delete key method

1. Place the insertion point before the first character of the
text to be deleted.

2. Press DELETE

3. Repeat step 2 as necessary.

Backspace key method
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1. Place the insertion point after the last character of the text
to be deleted.

2. Press BACKSPACE and repeat as necessary.
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INSERT THE DATE AND TIME

Along with standard text, you can also easily insert the current date and time
in a document by using the Date and Time dialog box, illustrated
in Figure 1-8. You can choose to insert a fixed date and time, or you can

instruct Word to automatically update the date and time each time the
document is opened.

Date and Time [T | =]

Available formats:

26/09/2007 .
YWednesday, 26 September 2007

Language:

English (United Kingdom) IEI
26 September 2007
26/09/07

2007-09-26
26-5ep-07

26,09, 2007

26 Sep, 07
September 07
Sep-07

26/0%/2007 13:41
26/09/2007 19:41:54
T41PM

7141:54 PM

19:41

19:41:54

[7] update automatically

[ oK ] [ Cancel

Figure 1-8: The Date and Time Dialog Box

L METHOD |

To insert the date and time into a document:

1. Place the insertion point at the desired location.

2. On the Insert tab, in the Text group, choose Date & Time.

3. In the Date and Time dialog box, from the Available formats
list box, choose the desired format.

4. If desired, select the Update automatically check box.

5. Choose OK.
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EXERCISE
’7

In the following exercise, you will insert and delete text in a

document.

As you work in Document2, refer to Figure 1-9 for assistance.

1. Make sure Document2 is open
in the current window

2. PressTaAB The insertion point moves to
the first tab stop in the

document.

3. Type: Memo to all CEEMA
Members: All
accommodation for the
CEEMA Conference should be
booked by the 1st of March to
get special package rates.
There is accommodation at
the following hotels:

4. Press ENTER two times The insertion point moves

down two lines.

Type London Hilton
Press ENTER
Type Grosvenor House

Press ENTER

© © N o O

Type Park Lane Hotel
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07/07/07

Memo to all CEEMA Members: All accommodation for the CEEMA Conference should be
booked by the 1st of March to get special package rates. There is accommodation at the
following hotels:

London Hilton

Figure 1-9: Document2—Inserting and Deleting Text Exercise
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

Place the insertion point in the
first sentence of the document
at the position immediately
following the word for

Press DELETE four times

Press BACKSPACE four times

Move the insertion point to the
beginning of the document

On the Insert tab, in the Text
group, choose Date & Time

In the Date and Time dialog
box, from the Available formats
list box, make sure the first
format is selected

Choose OK

Press ENTER three times

Switch to Regional
Information.doc

Near the top of the document,
place the insertion point after
the words ‘... a few hours’

Type This is a great way to
enjoy the beauty of nature
while still maintaining the
comforts of home.

The space and the word the
are deleted.

The word for and the space
before it are deleted.

The Date and Time dialog box
appears.

The MM/DD/YY format is
selected

The date is inserted at the
beginning of the document.

Two blank lines are inserted
after the date.

The text is inserted into the
document, and the text
following the inserted text
moves down the page as
necessary.
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SELECTING TEXT

Before executing many Word commands, you need to highlight, or select, the
section of text to which a command applies. When you select text, all
punctuation, blank lines, and special characters within the highlighted area
are included.

To select text, drag the mouse pointer over the desired text. When the
mouse pointer is positioned over an area that has been selected, the pointer
changes from an I-beam to a diagonal left pointing arrow. Alternatively, you
can use the keyboard method to select text, which requires placing the
insertion point in the desired location and then using the arrow keys to
highlight the text. Word also lets you use mouse shortcuts, outlined

in Table 1-2, to select text. To deselect selected text simply click anywhere
outside the selected area in your document or press a directional arrow key.

Mouse Shortcut Result

Double-click a word Selects the word.

Hold CTRL and click in a sentence | Selects the sentence.

Triple-click in a paragraph Selects the paragraph.

Move the pointer in the left margin | Selects the corresponding line.
until it changes to a diagonal right
pointing arrow, then click

Move the pointer in the left margin | Selects the corresponding lines.
until it changes to a diagonal right
pointing arrow, then drag up or
down

Move the pointer in the left margin | Selects the entire document.
until it changes to a diagonal right
pointing arrow, then triple-click

Table 1-2: Mouse Text Selection Shortcuts
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_ METHOD |

To select text:

Keyboard method

1. Place the insertion point where you want to begin selecting.
2. Press and hold SHiFT

3. Use the directional arrow keys to highlight the desired text.

Mouse method

1. Position the mouse pointer where you want to begin
selecting.

2. Drag the mouse to highlight the desired text.

Mouse shortcut method

1. Position the mouse pointer over any part of the desired
text.
or

1. Position the mouse pointer over the appropriate location in
the left margin until it changes into a diagonal right pointing
arrow.

2. Drag or click the mouse button the appropriate number of
times.

To deselect text:

1. Click anywhere outside the selection.
or

1. Press any directional arrow key.

EXERCISE
’7

In the following exercise, you will select text.
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10.

11.

12.

13.

14.

15.

16.

Make sure Regional
Information.doc is open in the
current window

At the top of the document, in
the first paragraph, double-
click the word London

Click outside the selection
Place the mouse pointer
immediately before the word
London, and then drag to
highlight the entire word
Click outside the selection
Place the mouse pointer
immediately before the word
London, then hold the SHIFT
key while pressing the RIGHT
ARROW six times

Press LEFT ARROW

Triple-click the word London

Click outside the selection
Place the mouse pointer in the
left margin next to the first line
of the first paragraph until the
pointer turns into a diagonal
right pointing arrow

Drag the mouse down a few
lines

Click outside the selection
Place the mouse pointer in the
left margin until it turns into a
diagonal right pointing arrow

Triple-click the mouse button.

Press DOWN ARROW

Switch to Document?2

The word and trailing space
are selected.
The text is deselected.

The word is selected.

The text is deselected.

The word is selected.

The text is deselected.

The entire paragraph is
selected.

The paragraph is deselected.

Multiple lines of text are
selected.

The lines of text are
deselected.

The entire document is
selected.

The text is deselected.
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REPLACING AND DELETING BLOCKS OF TEXT

You can delete an existing block of text and insert a new one in a single step
by replacing or typing over the existing text. This saves you time because it
decreases the number of keystrokes you must use. To replace text, select the
text you want to replace, then begin typing the text you want. The selected
text is removed from the document and the new text appears in its place.

Another method of replacing text is to activate the overtype mode. Normally
when you type, you are working in insert mode, and Word automatically adds
any new text to the existing text. When you type in overtype mode, Word
places new text over the existing text. Be careful using the overtype mode;
you can easily type over text you want to retain.

If you want to delete a block of text without entering any alternative text,
select the desired text and then press the DELETE key.

_ METHOD |

To replace a block of text:

Selection method
1. Select the text to be replaced.
2. Type the new text.

Overtype method
1. Place the insertion point immediately before the first letter
to be replaced.

2. On the Word Status bar, right mouse click and select
Overtype. See Figure 1-10. Insert appears on the status bar to
indicate you are in OVERTYPE mode.

3. Type the text. Your typing overtypes the existing text.
4. To switch off OVERTYPE mode, reverse (2).

To delete a block of text:

1. Select the text to be deleted.
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2. Press DELETE
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Customize Status Bar

Formatted Page Number 25
Sgction 1
|V | Page Humber 25 0f 46

Vertical Page Position

o Line Number

% Column

o [V] word Count 3,240
2 \z\ Spelling and Grammar Check Errors
e [V tenguage English (United States}
= [V sianatures off
T \7\ Informatian Management Palicy off
= [V pemissions o
B Track Changes off
E Caps Lock off
) [V] ouetype Insert)
; Selection Mode

?‘ Macro Recording ot Recording
2 [V wiew shorteuts

5 [v zoom 100%]
ol [V zoom stider

Page: 250746 | Words:8,240 | B English (United States) | Insert |

Figure 1-10: Options on the Word Status Bar from Right Mouse Click. With Overtype
Highlighted

EXERCISE
’7

In the following exercise, you will replace and delete blocks of text.

1. Make sure Document2 is open
in the current window

2. Inthe first sentence, select the
word hotels

3. Type complexes The word complexes replaces
the word hotels.

4. Inthe same sentence, place
the insertion point immediately
to the left of the word March
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On the Word Status bar, right
mouse click and select (check)
Overtype

Type April
On the Word Status bar, right
mouse click and deselect

(uncheck) Overtype

In the first sentence, select by
MEMO to CEEMA Members

Press DELETE

Overtype mode is activated.
Insert is visible on the Word
Status Bar

The word April replaces the
words March.

Overtype mode is deactivated.

Insert is no longer visible on
the Word Status Bar.

The selected text is deleted.
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MOVING AND COPYING TEXT

Word enables you to cut and paste blocks of text from one part of a
document to another. When you cut a selected portion of text, the text is
removed from the document and placed on the Clipboard, a temporary
storage area. When you paste text, a copy of the text on the Clipboard is
placed into the document. The cut piece of text remains on the Clipboard
until another block of text is placed on the Clipboard or until you shut down
your computer. As long as the text remains on the clipboard, you can
continue to paste the same text in different locations throughout your
document.

Word also enables you to copy and paste text from one part of the document
to another. When you copy a selected portion of text, a duplicate of the text
is placed on the Clipboard, but the text is not removed from the document.
As when cutting and pasting text, you can continue to paste the same portion
of text throughout the document as long as the text remains on the
Clipboard.

To move text quickly over a short distance, you can select the text and then
drag it to the desired location. As you drag, the selection appears to stay in its
original position, and the mouse pointer becomes an arrow with a shaded
box and insertion point drops down line by line on the page as you drag down
(or the reverse if you drag up). The shaded box represents the selected text.
You position the insertion point at the desired location in the document.
When you release the mouse button, the text moves to its new position. This
method is called drag-and-drop editing.

You can also drag to copy text. To do this, you hold down the CTRL key as you
drag the selection to an additional location.
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_ METHOD |

To move text:

Cut and paste method
1. Select the text.

2. On the Clipboard group on the Home tab, click the Cut
button.

or
2. Right click and choose Cut.

3. Place the insertion point where you want the text to be
inserted.

4. On the Clipboard group on the Home tab, click the Paste
button.
or

4. Right click and choose Paste.

Drag-and-drop editing method
1. Select the text.

2. Drag the selected text, placing the mouse pointer’s
insertion point at the desired location.

To copy text:

Copy and paste method
1. Select the text.

2. On the Clipboard group on the Home tab, click the Copy
button.
or

2. Right click and choose Copy.

3. Place the insertion point where you want the text to be
inserted.

4. On the Clipboard group on the Home tab, click the Paste
button.
or

4. Right click and choose Paste.

Drag-and-drop editing method
1. Select the text.
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2. Press and hold the CTrL key as you drag the selected text,
placing the mouse pointer’s gray line at the desired
location.
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EXERCISE
’7

In the following exercise, you will move and copy text.

10.

11.

12.

13.

Open CEEMA overview

Near the bottom of page 2,
under the heading About the
CEEMA Convention, select the
first paragraph and the blank
line following it

On the Clipboard group on the
Home tab, click the Cut button

Near the top of page 1, place
the insertion point directly
before the S at the beginning
of the heading SELECTED
LONDON ACCOMODATION

On the Clipboard group on the
Home tab, click the Paste
button

Scroll down until SELECTED
LONDON ACCOMODATION
positioned at the top of the
screen

Scroll up on the page and, in
the first paragraph, select the
words CEEMA Conference

On the Clipboard group on the
Home tab, choose Copy

In the next paragraph, at the
end of the first sentence, place
the insertion point before the
full stop

On the Clipboard group on the
Home tab, choose Paste

Scroll down on the page and
place the insertion point before
the words Attractions within the
City

The paragraph is removed
from the document.

The paragraph is inserted on
page 1.

The text is copied and remains
in its original location.

The words CEEMA
Conference are inserted.
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14. On the Clipboard group on the The words CEEMA

Home tab, click the Paste Conference are inserted into a
button second location.
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MODIFYING PAGE BREAKS

Word automatically determines where each page of a document should
begin and end by inserting automatic page breaks. As you create and edit
multipage documents, you might find that you need to manipulate the
automatic page breaks. You can quickly create a manual (forced) page break
by clicking the Page Break button in the Pages group on the Insert tab. To see
more Breaks options, on the Page Layout tab, in the Page Setup group click
the Breaks button to see a drop down viewing pane of Page Breaks options
and definitions (see Figure 1-11). This subject is covered in more detail in
Module 3 of the course.

Manual page breaks override the automatic page breaks created by Word.

Document? - Microsoft Word

Page Layout References Mailings Review View
— = 1 [= = =) O

Bya [j 1= Breaks = | ﬁ I‘qj m Indent
‘J : Page Breaks Leftt 1.27cm 5
ns Orientation Size Columns o
2 = = Page Right: 0 cm z

3 Mark the point at which one page ends

Page Setup —\W and the next page begins, E Parag

- x|
Column I - ’
Indicate that the text following the column

break will begin in the next column.

Text Wrapping
Separate text around objects on web
pages, such as caption text from body text,

R S

g

Breaks

Next Page
Insert 3 section break and start the new
section on the next page,

-

li  |\|\ L.

Continuous

Insert a section break and start the new
section on the same page.

m

Even Page
Insert a section break and start the new
section on the next even-numbered page.

[

Odd Page
Insert a section break and start the new
section on the next odd-numbered page.

[

Figure 1-11: The Page Breaks Drop Down Viewing Pane

Page breaks are displayed in different ways on your screen depending on
which view is activated. When your document is displayed in Print Layout
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view, both types of page breaks, automatic and manual, are indicated by the
separation of each page in the document window. When your document is
displayed in Draft view, automatic page breaks are indicated by a single
horizontal line across the page, and manual page breaks are indicated by a
single horizontal line with the words Page Break in the center of the line. If
you want to delete a manual page break, display the document in Draft view
first.
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_ METHOD |

To insert a manual page break using the Break dialog box:

1. Place the insertion point at the desired location.

2. Click the Page Break button in the Pages group on the Insert
tab.

To insert a manual page break using the keyboard:

1. Place the insertion point at the desired location.
2. Press CTRL+ENTER

To change the view of a document:
1. On the View ribbon tab, choose the desired view.

To delete a manual page break:

1. Make sure the document appears in Draft view.
2. Place the insertion point on the manual page break.
3. Press DELETE

EXERCISE
’7

In the following exercise, you will insert and delete page breaks.

1. Make sure Regional
Information is open in the
current window
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10.

11.

12.

13.

14.

15.

Scroll through the document and
examine the positions of the
automatic and manual page
breaks

Near the bottom of the first page,
place the insertion point before
the heading Kew Gardens

Click the Page Break button in
the Pages group on the Insert
tab.

Switch the ribbon to the View tab

View the document in Draft view,
then back to Print Layout

Place the insertion point before
Syon House

Press CTRL+ENTER

Scroll down and place the
insertion point on the page break
below the heading
Accommodation

Press DELETE
Place the insertion point
immediately before the heading

Accommodation

Insert a manual page break

From the View menu, choose
Print Layout

Scroll through the document and
examine the separation of the
pages

From the View menu, choose
Draft

Word inserts a manual page
break, and the heading moves
to the top of the next page.

The Ribbon buttons change to
View option groups

Word inserts a manual page
break, and the heading moves
to the top of the next page.

The page break is deleted.

The heading moves to the top
of the next page.

The view changes to Print
Layout.

The view changes to Draft.
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FINISHING DOCUMENTS

After you finish working with a document, you should save the document so
that you have it available to access in the future. You might also want to print
the document. When you no longer need the document displayed, you
should close it to remove it from memory.

SAVING DOCUMENTS

When a document is displayed in the document window, it is saved only in
the computer’s memory. If your computer loses power, or if an error occurs
in your program, you will lose all the information you have entered.
Therefore, you should save your document to a disk periodically as you are
working on it. In Word, you save a document as a file that is made up of a
series of related pages.

Create New Folder

Open @

Look in: | ) Word 2007 L1 course data b @-3 X CuE-
Size  Type [rate Modified el
r’J Z5KE  Microsoft Offi... 18/02/2002 10:59
T;;‘;Edes 26KB Microsoft OFfi... 18/02/2002 17:30
Iﬂ_]nccommodations.doc Z9KE  Microsoft Offi.,. 25/05/2004 20:23
: iﬂ_’]nttractions.doc 35KE  Microsoft Offi... 18/02/2002 17:54
My I.ilecent £ | Attractions. bkl 18KE HTML Document  18f02/2002 18:23
e & | AWPP dates.htrml 1KE HTML Document  28/01/1997 09:48
IE_I]AWPP overview, doc 31 KB Microsoft Offi... 14/02/2002 10:47
s IE_I]AWPP web page.doc 24 KB Microsoft Offi,..  14/02/2002 10:47
— ) Bloamie Fax,doc 20KE Microsaft OfFi,..  1402/2002 10:47
Desktop £ | CEEMA dates,htmi 4KB HTML Document  18/02/2002 11:35
: 1) CEEMA overview. doc 29FKB Microsoft Offi,..  18/02/2002 13:53
y iE_I]CEEMP. web page.doc 24KE Microsoft OFfi... 18/02/2002 16:22
-"/ IE_I]Convention.doc 26 KB Microsoft Offi,.. 19/02/2002 12:29
My Doclments || [0 icney World.doc 25KB  Microsoft OFfi... 14/02/2002 10:46
== @DISNE\".DOC Z7KE  Microsoft OFfi.., 14f02/2002 10:46
,,J)Jlg lE_I]Entertainment.doc 14KB Microsoft OFFi... 15/02/2002 14:44
My Computer :E_I]First day lecture, doc 26 KB Microsoft OFfi,., 14/02/2002 10:46
Iﬂ_]FIorida information.doc ZSKE  Microsoft OFfi.., 14/02/2002 13:52
"} Iﬂ_]London.doc Z5 KB Microsoft Offi.,. 14/02/2002 10:46
3 W marning schedule mema.doc 23KB  Microsoft OFfi... 18/02/2002 18:00 |
My Metwark. | File pame: |
Places — =
| Files of type: | all Files (+.# v

Figure 1-12: The Save As Dialog Box
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When you use the Save As command, the Save As dialog box, illustrated

in Figure 1-12, appears. You can use the Save As dialog box to name a new
document or to rename an opened document and to specify the folder in
which you want to place the document. By default, when you save a new
document file, Word adds the filename extension .doc.
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To organize your work, you might want to store different groups of files in
their own folders. You can create a new folder in which to save your
documents by using the Create New Folder button in the Save As dialog box.

Word lets you use the Save command to save a document that already has a
filename. This command automatically saves the document under its
previously defined filename and folder. If you use the Save command when
you have not yet given a filename to your document, Word displays the Save
As dialog box.

L METHOD |

To save a new document or to save a document under a different
name:

1. Click the Office button and choose Save As.

2. Inthe Save As dialog box, in the Save as type drop-down list,
make sure Word Document (*.docx) is selected.

3. Inthe Save In drop-down list box, make sure the desired folder is
displayed.

4. In the File name text box, delete the current text and type the
new filename if necessary.

5. Choose Save.

To save a document under the same filename and folder:

1. Click the Office button and choose Save.
Or

1. On the Quick Access Toolbar, click the Save button.

To create a new folder:

1. Click the Office button and choose Save As.

2. Inthe Save As dialog box, in the Folders list, select the folder in
which you want to place the new folder.

3. Click the Create New Folder button.

4. Afolder is created with New Folder in blue. Delete the
current text and type the name of the new folder.

5. Choose OK.
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EXERCISE
’7

In the following exercise, you will save documents.

10.

11.

Make sure Regional
Information is open in the
current window

Click the Office button and
choose Save As

In the Save As dialog box, in
the Save as type drop-down
list, make sure Word
Document (*.docx) is selected

In the Save in drop-down list
box, make sure the Word 2007
L1 Data folder is displayed

In the File name text box,
delete the current text and type
Regional Information 1

Choose Save

In the first sentence of the
document, replace the word
crowds with the word chaos

On the Quick Access Toolbar,
click the Save button

Switch to Document2

Click the Office button and
choose Save As

In the Save As dialog box, in
the Save in drop-down list box,
make sure the Word 2007 L1
Data folder is displayed

The Save As dialog box
appears.

The file will be saved as a
Word document.

The file is saved in the Word
2007 L1 Data folder as
Regional Information 1.doc.
The dialog box closes, and the
document remains open in the
document window. The new
filename appears in the title
bar.

The edited document is saved
under the same name.

The Save As dialog box
appears.
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12.

13.

14.

15.

16.

17.

18.

Click the Create New Folder
button

Delete the current text (New
Folder) and type CEEMA1

Choose OK

In the Save in drop-down list
box, display the new folder
CEEMA1

In the File name text box,

delete the current text and type

Demo list

Choose Save

Switch to Regional
Information 1.doc

A folder is created with New
Folder in blue.

A new folder, CEEMA1, is
created in the Word 2007 L1
Data folder

Demo list.doc is placed in the
CEEMAL1 folder.
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PREVIEWING DOCUMENTS

Before printing a document, you might want to preview its printed
appearance on-screen. You use Print Preview, illustrated in Figure 1-13, to
display a document as it will look when printed. This enables you to make
last-minute changes before you print.

In Print Preview, as in other views, you can edit your document. To place the
insertion point in the document in Print Preview, deselect the Magnifier
button on the toolbar/ribbon. While you are editing, you can periodically use
the toolbar’s Magnifier and Zoom features to adjust the size of the document
text and layout on the screen. This enables you to examine the affects of your
changes. Using the Print Preview toolbar, you can also choose the number of
pages displayed on the screen.

One Page

Two Pages
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Figure 1-13: Print Preview
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_ METHOD |

To use Print Preview:

1. Make sure the desired document is open in the current window.

2. Click the Office button, then click the [more options] pointer next
to the Print button and choose Print Preview.

To zoom in or out in Print Preview:

1. On the Print Preview toolbar, make sure the Magnifier check box
is selected (checked).

2. Position the mouse pointer over the document.
3. Click to select the desired page, if necessary.

4. Click in the desired area of the document when the magnifying
glass pointer has a plus sign (+) in it to zoom in.
or

4. Click in the desired area of the document when the magnifying
glass pointer has a minus sign (-) in it to zoom out.
or

1. On the Print Preview toolbar, click the Zoom button and in the
Zoom dialog box select a zoom option.
or

1. On the Print Preview toolbar, click the Zoom button and in
the Zoom dialog box type a zoom percentage. Then press
ENTER

To change the number of pages displayed in Print Preview:

1. On the Print Preview toolbar, click the Two Pages button.
or

1. On the Print Preview toolbar, click the One Page button.

To move the insertion point into the document in Print Preview:

1. On the Print Preview toolbar, deselect the Magnifier check box.
2. Inthe document, click at the desired location.

To exit Print Preview:
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1. On the Print Preview toolbar, click the Close Print Preview
button.
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EXERCISE
’7

In the following exercise, you will use Print Preview.

10.

11.

Make sure Regional
Information 1.doc is open in
the current window

Click the Office button, then
click the [more options] pointer
next to the Print button and
choose Print Preview.

On the Print Preview toolbar,
click the Two Pages button

Click to change to One Page,
then back to Two Pages.

On the Print Preview toolbar,
make sure the Magnifier check
box is selected

Click the first (top center) page
of the document

Click the second page of the
document

On the Print Preview toolbar,
deselect the Magnifier check
box

On the second page of the
document, click immediately
before the words The Ritz

Press ENTER

On the Print Preview toolbar,
click the One Page button

The document appears in Print
Preview.

2 pages of the document are
displayed.

2 pages of the document are
displayed.

The mouse pointer becomes a
magnifying glass with a plus
signin it.

Magnification of the page

increases, and the plus sign
changes to a minus sign.

The insertion point moves into
the document.

Additional space is inserted
above the heading.

The entire page is displayed.
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12. On the Print Preview toolbar, Print Preview closes.
click the Close Print Preview
button

13. Switch to CEEMA overview

Ask your instructor to show you the Full Screen Reading viewing feature.
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PRINTING DOCUMENTS

After you preview the printed appearance of your document, you are ready
to print it. You can print a document from Print Preview or from the
document window. When you choose the Print command from the Office
button drop down menu, Word opens the Print dialog box, illustrated

in Figure 1-14. Using the Print dialog box, you can change options for your
print job, such as the number of copies to print. If you use the Quick Print
button on the Print options list however (shown in Figure 1-15), Word
automatically prints your document using the default Windows print settings.

print s
Printer
MName: =5 HP Photosmart C5100 series |Z| Properties
Status: Off Line: 1documents waiting Find Printerss
Type: HP Photosmart C6100 series
Where:  192.168.0.103_1 Print to file
Comment: Manual duplex
Page range Copies
@ al =

Mumber of copies: |1

Current page Selection

Pages: 1?
Type page numbers and/or page l
ranges separated by commas counting

from the start of the document or the

section. For example, type 1, 3, 5-12

or plsl, pis2, p1s3-pas3

l‘? V| Collate

Print what: | Document |Z| Zoom
Print: All pages inrange |z| Pages per sheet: 1page IZ|
Scale to paper size: Mo Scaling IZ|
Options... QK ] | Cancel |

Figure 1-14: The Print Dialog Box
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! Preview and print the document
| New |
o i Print
] Select a printer, number of copies, and |
7 Open ather printing aptions befare printing,

Quick Print

ﬂ? S Convert @ Send the document directly to the default

printer without making changes.

Iy Print Preview i
H Save ﬁ Preview and make changes to pages before ]
printing,

l Save As b

"_~ Print »
N

;"(:7 Prepare »

Send 3
E‘l:. Publish ¥
5
Close

[ 13 ward options | [ X Exit ward

Figure 1-15: The Quick Print Feature
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_ METHOD |

To print a document using default settings:

1. Display the document in Print Preview.

2. On the Print Preview toolbar, click the Print button.
or

1. Click the Office button, then click the [more options]
pointer next to the Print button and choose Quick Print.

To print a document using customized options:

1. Click the Office button, then choose Print, then Print again.
2. In the Print dialog box, set the desired options.
3. Choose OK.

EXERCISE
’7

In the following exercise, you will print documents.

1. Make sure CEEMA overview
is open in the current window

2. Display the document in Print
Preview

3. On the Print Preview toolbar, The document prints.
click the Print button

4. Close Print Preview
5. Switch to Demo list

6. From the Office button, choose  The Print dialog box appears.
to Print

Microsoft Word 2007; Introduction 14 August, 2009

Module 1; Page 57 version 1.0



7. Inthe Print dialog box, in the
Copies area’s Number of
copies scroll box, delete the
current text and type 2

8. Choose OK The dialog box closes, and two
copies of the document print.
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CLOSING DOCUMENTS

Closing a document removes it from your screen but leaves you in Word so
that you can begin working with another document. You can close a
document through the Office button options menu or by clicking the Close
Window button in the document window (extreme top right of the screen).

Before you close a document, you should make sure that you save your work
if you want to retain any changes you have made since you last performed a

save. If you have not already saved a document, Word gives you a chance to

do so when you close it.

Microsoft Office Word @
! i Do you want to save the changes to Document2?
[ es ] | Mo | | Cancel

Figure 1-16: The Save Changes Warning Box

L METHOD |

To close a document:

1. From the Office button options menu, choose Close.
Or
1. In the document window, click the Close Window button.
2. If the save the changes warning box appears, choose Yes to
save the changes to the document.
Or
2. If the save the changes warning box appears, choose No to
discard the changes to the document.
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EXERCISE
’7

Make sure Demo list is open
in the current window

From the Office button options
menu, choose Close
Make sure CEEMA overview

is open in the current window

In the document window, click
the Close Window button

In the warning box, choose No

From the Office button options
menu, choose Close

In the warning box, choose
Yes

In the following exercise, you will close documents.

Word closes the document,
and the previous document
appears.

Because you have not saved
this document since the last
editing, the save the changes
warning box appeatrs.

Word closes the document
without saving the changes,
and Regional Information 1
appears.

Because you have not saved
this document since the last
editing, the save the changes
warning box appears.

Word saves the document
under the same filename and
then closes the document.
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The Courseware Shop

ASSIGNMENT

1. Open Attractions.doc.

2. View the document in one of the different word view. Use the View tab of the
ribbon.

3.  Move the insertion point to the end of the document, then delete the last
sentence.

4. Move the insertion point to the third sentence of the document the section
on the Houses of Parliament and select the words Palace of Westminster
move them to the end of the paragraph

5. In the same paragraph, use the copy and paste method to copy the word
Commons to immediately after the word chimes.

6. Using the Find feature, find the sentence that contains the text William Il &
Mary Il then, immediately after the found text, insert a comma (,), press
SPACEBAR, and insert the text and their large courts.

7. Reset the browse object to Browse by Page.

8. In a new document, insert the current Date and Time in the format of your
choice.

9. Press ENTER twice, and then type the name and address shown below.

Mr Andrew Bacon
59 West Street
Bedminster
Bristol
BS3 1PZ
10. Use Overtype (INSERT) mode to change the postcode to BS4 8PY. Then,
reactivate Insert mode.
11. Use the cut and paste method to move the fourth line of the address to the
third line of the address
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12. Inthe Data folder, save the document as Business addresses.doc.
13. Switch to Attractions.doc.

14. Use the selection method to replace the word Museums with the word
Galleries

15. Change the view to Print Layout and scroll through the document and
examine where the pages break. Then, change the view back to Draft.

16. Delete the manual page break in the document. Then, scroll down and insert a
page break immediately before the heading Regional Attractions

17. In the Data folder, create a new folder named New Documents, and then
save the document as New information.doc in the new folder.

18. In Print Preview, zoom in to see the heading on the second page. Change the
heading Regional Attractions to read Where to Go.

19. Display both pages of the document.

20.  Print the document and then exit Print Preview.
21. Switch to Business addresses.doc.

22. Print two copies of the document.

23. Close both open documents, saving any changes.
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